
VERSION 2.5 User Guide Addendum



07292011



User Guide Addendum

3

What’s New
Version 2.5
 Welcome to CounterSketch Studio 2.5

Inventory Mode
Take control of your library with custom jewelry collections exclusive to your store. This new feature allows you to easily 

create and manage multiple collections designed by any number of CounterSketch users within your store with each design 

customized and saved to your specifi cations. Publish the design to your searchable library rendered in any metal color and 

gemstone combination. Now when you search within CounterSketch Studio you are not limited to the stock Starting Point 

Inventory, but can choose to search your unique items saved the way you want them to display!

Custom Prototypes
Order custom-designed prototype samples right from Inventory Mode. The 

corresponding design is saved in your Custom Collection so the prototype your 

client holds in their hand matches exactly what’s on screen. The beautifully-

crafted prototypes look like the real deal. And because they are ‘brass and glass’, 

if you choose to do so, you can allow customers to browse your jewelry independently 

and enjoy a stress-free shopping experience. Create your own display or purchase an interactive 

display from Stuller.

Managing Portfolios
Clean up your old and out-of-date portfolios. View all of your Custom Collections as well as your Customer Portfolios at a 

glance and choose to copy, move, delete, or view favorites all from within the Manage tab within Inventory Mode. This new 

workfl ow allows you to easily organize and purge outdated fi les and information.

Work Anywhere
Practice or work in CounterSketch Studio from your home computer. The new license transfer feature allows you to quickly 

unregister your license and transfer it to another computer.

Backup and Restore
Rest assured knowing that your CounterSketch Studio information and designs are safely backed up. This new feature 

prompts a backup of your portfolios, collections, quote history, and catalogs that can be restored at any time.

ently 

e an interactive 
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This addendum should be viewed as supplementary to the 

CounterSketch Studio 2.0 User Guide and not as a stand-alone 

publication. We recommend viewing the complete User Guide for an 

in-depth view of CounterSketch Studio and how to design and sell 

custom jewelry using all the program’s functions. 

Using the Online User Guide
The User Guide and Inventory Mode Addendum are always at hand! 

A printable Adobe PDF version can be found under Help in the 

CounterSketch Studio menu bar.

If the Adobe Acrobat Reader does not open properly, install it from the 

CounterSketch Studio install disk or download it online at 

www.acrobat.com.

Notes and Tips
Throughout the text there are User Tips and important Notes 

designed to call your attention to points of interest and informa-

tion you will need to know. 

NOTES: Appear in a red italic font. Notes are easy to pick out if 

you choose to skim through the User Guide and just read these 

important points.

USER TIPS
User tips have a purple header and gray text. It’s easy to skim 
through the User Guide and pick them out.

Get the most out of
Version 2.5
An introduction from Gemvision and Stuller

Gemvision and Stuller are deeply committed to helping you be the best 

CounterSketch Studio user you can be. Even though we boast how easy 

it is to use CounterSketch Studio, a tool is only as good as how it is be-

ing used! We offer many resources to help you along your journey with 

CounterSketch Studio, but your success with CounterSketch Studio is up 

to you and you alone. 

One of the greatest challenges you will face with CounterSketch Studio 

and what makes it a very powerful tool is the vast number of Starting 

Point Inventory models and the dissimilarity of the controls found within 

each design. When selling jewelry from your showcase, you must be 

familiar with your inventory. If you don’t know what you have, you can’t 

sell it. The same concept holds true for CounterSketch Studio. To be 

successful you must dedicate your time and energy to understanding 

your Starting Point Inventory. 

This is no small task, but the new features found within CounterSketch 

Studio 2.5 will help you. With over 2,300 models and climbing, it may 

seem like a daunting task to become familiar with this amount of inven-

tory, but fear not! Use Inventory Mode and locate 10-20 Starting Point 

Inventory models that are similar to the top sellers within your store. 

Practice modifying these designs and create a Custom Collection, sav-

ing the slider’s default position to display the model the way you want. 

Then publish the collection and even order ‘brass and glass’ prototypes 

of the models for your showcase. Now in CS Mode you can limit the 

search results to models you are comfortable working with in your 

Custom Collection. CounterSketch Studio also gives you a visual cue if 

this item has been ordered and is available in your showcase. That way 

during a design consultation you can show your customers a physical 

example of the model. 

Over time you can add designs to your Custom Collections until you are 

comfortable selling with the entire CounterSketch Studio library. Before 

you know it, you will feel at ease with CounterSketch Studio and this 

new approach to selling. Let’s face it, retail jewelry is evolving. When 

you purchased CounterSketch Studio, this alone showed your level of 

commitment to growing your business and providing your customer with 

the latest and greatest retail buying experience. So dig deep and read 

on to learn about all of the exciting new tools available to you within 

CounterSketch Studio 2.5!

Gemvision offers a variety of different approaches to training:

• Training at Gemvision, Stuller, or one of our remote locations

• Online instructor-led training

• On-demand training module

If you have any questions about classes, contact:

Shelly Ellis

shelly_ellis@gemvision.com

1.800.357.6272 ext. 104

S T R A T E G I C  P A R T N E R S
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Here’s a quick overview of a few changes 
you may notice when working within 
regular CS Mode:

• Under the Search tab, the Go button has now been replaced by a 

more obvious Start Search button.  

• If you have adjusted the user interface scaling and wish to have it 

reset to 100%, double-click on the number fi eld next to the slider 

located in the bottom right-hand side of 

the interface.

• Under Edit, you now have the ability to copy and paste text fi elds.

• Within the Search Mode section, a new icon appears 

in the spot where the Browse and Catalog Views were 

previously located. This is the new Custom Collection 

Search Mode. Select this button to search your Custom 

Collections once they’ve been created.

• A new icon now lives next to the Hide/Show Designs icon. 

This icon houses the Browse and Catalog Views and acts 

as a toggle switching between the two. 

• The Customer Info pop-up 

menu is more noticeable and now you can select and add the 

client’s ring size to their portfolio information.

License Transfer Checklist
 □ Original CounterSketch Studio 2.0 or 2.5 install disc

 □ 16-digit license key #

Your 16-digit code appears as a sticker within the CounterSketch 

Studio CD case. For those users receiving 2.5 as an update, use 

the 16-digit code from your original install disc.

 □ Stuller.com login

 □ Stuller.com password

It is recommended that you set all CounterSketch Studio installed 

computers to Automatic Update (Located within the Preferences 

Section). This is so each machine keeps current with every 

CounterSketch Studio program and library update available. See 

the CounterSketch Studio manual for more details.

When opening CounterSketch Studio on the new computer you will re-

ceive a prompt to enter your 16-digit license key, Stuller.com login and 

Stuller.com password, so remember to keep this information handy. The 

fi rst time you open CounterSketch Studio on the new machine you will 

have to set up your Account Information again including your markups. 

Enter your information in the appropriate fi elds and you’re ready to go! 

NOTE: Remember, CounterSketch Studio will only be usable on one 

computer per license at a time and will always need to be unregistered from 

the fi rst computer before you are able to use it on the new machine. Don’t 

forget to unregister before leaving work if you plan on using the program at 

home or vice versa! 

License Transfer
Want to spend some time learning and practicing CounterSketch 

Studio after business hours? Need to prepare for an upcoming design 

consultation or want to spend some time creating a few Custom 

Collections and wish you could work from your home PC? Now you can 

transfer your CounterSketch Studio license quickly and easily from one 

computer to another. Follow these simple steps and walk the path to 

CounterSketch Studio freedom!

Install CounterSketch Studio onto the desired computer(s) using your 

original CounterSketch Studio 2.0 or the new 2.5 install disc. For details 

on the install process, see the Software Installation Instructions in the 

User Guide or the back of the 2.5 install disc. In order to move your 

license to a new machine, you will fi rst need to unregister the old com-

puter. To do this go to File>Unregister Computer. Clicking Yes will 

unregister the machine and automatically close CounterSketch Studio. 

Now you are ready to move your license.
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Password Permissions
You now have the ability to customize the security settings to your 

store’s personal preferences. Select Edit>Account Info, and you 

will receive a prompt to enter your Stuller.com password. Once entered, 

you will have access to the Account Info menu. Along the bottom of the 

Account Info menu, under Application Permissions, you may choose 

to add a prompt for a password when trying to gain access to the 

Preferences section and/or the Inventory Mode section of the program. 

If you want to allow access to Inventory Mode and/or the Preferences 

menu, however you don’t want to give out your Stuller account informa-

tion (This is the same information you use to place orders on Stuller’s 

website), just type a new password into the text box and it will be saved 

when you click Close. Keep in mind, you will always use your original 

Stuller.com password to access the Account Info section itself as this is 

where proprietary markup information is stored.

The New Backup/Restore Feature 
Helps You Sleep At Night
In the event you have hard drive failure or your CounterSketch 

Studio computer needs to go into the shop, you can restore your 

CounterSketch Studio fi les onto another computer and get up and run-

ning with CounterSketch Studio in no time with no loss of data by creat-

ing a copy or backup of CounterSketch Studio. Digital storage space is 

cheap in comparison to the countless hours you’ve spent during design 

consultations, creating Custom Collections and catalogs. Give yourself 

peace of mind and get in the habit of creating regular backups.

The Backup feature will save your Quote History, Catalog History, 

Preferences, Custom Collections, and Customer Portfolios (Including 

your customer’s personal information) – Basically everything of impor-

tance that you need.

To perform a manual backup, go to Edit>Preferences. Depending on 

your Account Info settings, you may be prompted to enter your pass-

word. In the Preferences menu, click on the new Backup & Restore tab. 

Specify where you would like to store the backup fi le within the Backup 

Directory Location text fi eld by clicking Browse. Be sure to save to an 

external location instead of your hard drive. Select the folder you wish to 

save your data in, or click Make New Folder to create a new one. Name 

the new folder and click OK. Next, click on Create Backup. Underneath 

the Backup Log, CounterSketch Studio will fi ll you in on what’s happen-

ing during the process. This backup information takes up a lot of hard 

drive space. We advise that you only keep the most recent two or three 

backups and delete the rest in order to save space on your computer. 

Wait until the backup is complete before you begin working and saving 

projects again, as this information may be lost during the process.

In the future, simply click Create Backup and CounterSketch Studio 

will automatically send the data to this location. At any time you may 

change the destination by clicking Browse again and specifying a new 

location or folder.

Quick Backup
Quick Backup is just another way to access the Backup feature. Access 

it quickly and easily by going to File>Quick Backup. The backup will 

automatically be saved to your predefi ned location.

Restore
Located below the Backup feature lives the new Restore feature. Click 

Browse to navigate to the folder where you previously created your 

CounterSketch Studio data backup. Once selected, click Restore. As 

an added safety net, CounterSketch Studio will ask you if you want to 

perform a backup of the current CounterSketch Studio before perform-

ing the restore.

IMPORTANT: Using the Restore feature to restore from a previous backup 

point can potentially DELETE projects that were created after the date of the 

restored backup. Please use caution and only use restore when absolutely 

necessary. Please be advised, the restore process may take a long time 

depending on the size and amount of portfolios being restored.

NOTE: Performing a backup or a Quick Backup can take 8-10 minutes or 

longer depending on your computer’s processor speed. Plan ahead and 

perform them when your computer is not in use.
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Import/Export
In the event you contact Technical Support and need to send them a fi le 

or you need to load a fi le into CounterSketch Studio that was sent to 

you, use the Import/Export feature. Located within the File drop-down 

menu, hover your curser over the Import/Export option to activate the 

fl yout menu. Here you can choose to either import or export a fi le. 

Use Import to load a .csg fi le into CounterSketch Studio by clicking 

Import. Browse to the location on your computer where the fi le is saved 

and click Open. Take note, importing a fi le will override any fi le that is 

CS Prototype Packages
If you’re a new CounterSketch Studio user, you may have 

purchased one of the four Starter Packages which include pre-

selected prototypes. If you are an existing user, you received the 

Original CS Sample Kit. To help you get started with Inventory 

Mode, all of the models from the kits and packages have automati-

cally been downloaded into the Custom Collection section and 

currently appear as; CS Package 1, CS Package 2, CS Package 3, 

CS Standard Package, and Original CS Sample Kit. 

Identify which package level you have within your store and mark 

the items In Stock that you own. These items have already been 

published so they are automatically searchable in CS Mode. Some 

package levels include the purchase of customized prototypes. Be 

sure to order your customized prototypes, and once received, mark 

Import Stuller Packages Button

If you delete, rename, or alter these collections in any way, you 

may download another copy of all fi ve by clicking Import Stuller 

Packages. Download as many copies as you wish at any time.

them as In Stock to indicate that they exist in your showcase. 

Learn more about the Show In Stock feature later in this addendum. 

Peruse these collections if you are interested in purchasing one 

of the CS Prototype packages. The models included within these 

packages represent current fashion trends and the individual stock 

prototypes within these packages are discounted heavily when 

purchased in their grouping.  If you wish to purchase individual al-

tered models, pricing starts at $150 but will vary in cost depending 

on model complexities. Contact Stuller for offi cial pricing.

currently active on the SketchPad. If you wish to save this fi le, make 

sure to Job Bag the active design prior to using the Import function.

Any design that is currently loaded onto the SketchPad can be exported 

and saved to your computer. To do so, choose the Export option. A new 

window will appear. Navigate to the location on your computer where 

you would like to store the fi le. In the File Name text box enter the 

desired name and click Save. The fi le is now saved to the location you 

choose with a .csg fi le extension. 
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Never before in the history of retail jewelry has it been possible 

to do all of this from the comfort of your jewelry store’s counter 

top – until now!

A new way of business... 
Introducing CounterSketch Studio 2.5 and the addition of Inventory Mode! 

Manage your virtual inventory with ease while you and your staff create 

custom lines of jewelry and prototypes exclusive to your store. Search the 

entire CounterSketch Studio library or choose to limit a search to your own 

Custom Collections. 

Further differentiate yourself from your competition with this revolution-

ary upgrade to CounterSketch Studio. Create your own unique Custom 

Collections and easily publish them. Your designs will then be displayed 

in up to 576 metal and gemstone color combinations, making each 

custom design within the collection searchable to your clients speci-

fi cations. Open any model within your Custom Collection and further 

customize the design to match your client’s vision right before their 

eyes. These designs will be saved on your computer alone, and will be 

exclusive to your store!

How to Use
Inventory Mode
Manage Your Digital Inventory

With CounterSketch Studio and Inventory 
Mode you can:
• Optimize a Search
• Create Custom Collections
• Manage your portfolios
• Order customized prototypes that will exist only in your store!
• Host custom design consultations
• Price a custom job with the click of a button
• Show a client how an item will look when being worn
• Generate beautiful photorealistic renders
• Manage your digital inventory
• Build custom-print catalogs
• Specify manufacturing details and order your unique designs 

directly from Stuller 
• Satisfy your customer with quick turnaround times
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To switch over to the Inventory Mode section 

of CounterSketch Studio, click on CS Mode 

located along the top right-hand corner of the 

interface and select the Inventory option from 

the drop-down that appears. Unless you’ve changed your password 

protection settings within Edit>Account Info, you will receive a prompt 

to enter your password.

Notice that the entire interface becomes trimmed in yellow. This color 

change acts as a visual cue that you are working within this new area 

of the program. You will also notice the program automatically rolls you 

over to the new Order & Manage tab. Before we talk in detail about this 

area of the program you will need to fi nd, alter and save some designs 

to manage - so let’s perform a general search. 

Perform a Search
Along with the new Order & 

Manage tab, when in Inventory 

Mode, you still have access to 

all of the standard action tabs 

including Search and Customize. 

To get started, click on the 

Search tab and perform a simple 

search of the CounterSketch 

Studio library of models. Select 

your search criteria such as 

metal, stone color, stone shape, 

etc., and click on the green Start 

Search button at the bottom of 

the menu. CounterSketch Studio 

will pull up models that fall within 

these specifi cations. Double-click on a selected model to load it onto 

the SketchPad and customize the design to your satisfaction using the 

sliders and functionality available for that item.

Ready for your customized design to become searchable as a Starting 

Point model? Maybe even as a custom-designed ‘brass and glass’ 

prototype for your store? When you’re satisfi ed with the design’s new 

look and ready for it to be a part of your Custom Collections, you will 

need to save the model by adding it to a Job Bag just as you would in 

regular CS Mode. Simply click on the plus sign located 

directly below the Job Bag’s thumbnail to capture and 

save the design. 

You will also need to name your new Custom Collection by double-

clicking on the title’s text fi eld. When it becomes highlighted, type in the 

desired name. Be creative – this information will transfer to CS Mode 

where you will search in front of your customers. Press Enter on the 

keyboard to save. If you wish, you may also name or add a note to the 

individual Job Bag itself by typing into the text fi eld located along the 

bottom right-hand side of the Job Bag. 

Once you’ve saved a few designs within a Custom Collection to work with 

in the Manage section, you’re ready to click on the Order & Manage tab. 

On the left side of the screen under the grey Inventory title bar, your 

entire saved inventory is divided into two main categories. These sec-

tions appear as Custom Collections and Customer Portfolios. These two 

sections are collapsible by clicking on the arrows located to the left of 

the headers. Click the arrows a second time to reopen them. Underneath 

Custom Collections live the other sub-categories – Published Designs, 

Ordered Samples and In Stock Samples. These sections will be ex-

plained in detail later in this addendum. First, it’s important to under-

stand the differences between these two main sections:

Think of Inventory Mode, think yellow and management - 

not customers! This color-coding is designed to help you 

distinguish the two modes from one another so that you don’t 

begin working and saving in the wrong mode by mistake.

Getting Started in Inventory Mode
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Custom Collections
Click on the title of the Custom Collection of your choice 

to activate it. You will notice that the Custom Collections 

bar will become highlighted in yellow. The Custom 

Collection and a breakdown of all it’s models and their 

corresponding information will appear in the center of 

the screen. Use the scroll bar on the right or the wheel 

on the mouse to scroll through your Custom Collection 

if it contains a lot of designs and is not viewable all at 

once. Click anywhere on an individual design’s informa-

tion line to select it.

The name of each collection and the date it was created 

will appear in the top left-hand corner of each individual 

collection. If you wish to rename a collection, simply dou-

ble-click on its title and the name will appear highlighted in 

blue. Type the new name into the fi eld and hit Enter when 

done. The new title will be saved accordingly. 

Job Bagging Tips 
Although you are not limited to the amount of 
Custom Collections you may create nor the 
amount of items you may have within each 
Custom Collection, when you are in Inventory 
Mode it’s best to only Job Bag fi nal designs to 
keep things simple and organized. 

In CS Mode the opposite is recommended. 
Switch to a “more Job Bagging the better” 
philosophy. As you are working with a client 
it is very important to save even slight 
variations of a design. If your customer 
decides they liked the design created a few 
modifi cations back versus the direction the 
consultation may be currently heading, you 
can quickly pull up that saved model.

Custom Collections Customer Portfoliosvs

Created in Inventory Mode Created in CS Mode

Created by staff for your store’s personal inventory Created during a design consultation with a customer

Job Bag only fi nalized designs Job Bag often to create a history of the design consultation

Can be published to become searchable Can’t be published unless moved to a Custom Collection

Searchable in CS Mode as an SPI model Only found within portfolio (not searchable as an SPI)
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Underneath the Custom Collection title 

bar you will notice a larger thumbnail 

image appears, corresponding to the de-

sign. If the item has not been published, 

a generic ring graphic will appear here 

with the text “Not Published” displayed. If 

published, rendered designs are arrayed 

in every metal combination available for 

that design. Click through them with the 

mouse to view each thumbnail. If any in-

formation was entered into the Job Bag’s 

text fi eld while in the Customize tab, it will 

appear below the image.

Design: The thumbnail image of the model composed as it was 

saved in its Job Bag within the Customize tab appears here. 

Favorites: The star image here corresponds to the Favorites 

ability within CounterSketch Studio to view multiple designs 

simultaneously. This is discussed further under View Favorites. 

Name: The original SPI model number will automatically appear 

here. If you like, you may change this by clicking in the fi eld 

and typing a new name or description into the text box. Click 

anywhere outside of the fi eld to save the information.

Designed by: In this section it automatically states the designer 

who created the original SPI. You have the option to insert your 

name here and take ownership over the new customized design. 

SPI: The original Starting Point Inventory number of the design 

appears in this section. This makes the model easily trackable if 

you wish to revisit the original model within Search.

Type: This description corresponds to the primary search crite-

ria under CS Mode. If any additional components are available 

for the specifi c design they will appear here (e.g. A ring and its 

accompanying bands).

1

2

3

5

4

6

Below is a breakdown of the information within the columns of each Custom Collection: 

4 51 2 3

Create New
If you are working within Inventory Mode’s 

Order & Manage tab and you wish to create 

an entirely new Custom Collection, click the 

star-shaped Create New icon located to the left 

on the title bar. A text box appears prompting 

you to name the new item. Enter a name inside 

the text box and click Apply. The new portfolio/

collection is now listed. 
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7

6 7 8

8

9

Published: Published means the item has been rendered in 

every metal and gemstone combination possible. Once an item 

is published, a check mark will appear here indicating it is now 

searchable as a Starting Point model. If the design has been 

moved to the Publish Queue and is waiting to begin publishing, 

it will state “In Queue” here. Visit the Publish Design section of this 

addendum for more info.

9

Quick View: Just need to take a quick look at the model instead? 

Simply hover your mouse over the thumbnail of the selected 

design to display a larger thumbnail image.

Ordered: If the design has been ordered as a ‘brass and glass’ 

prototype, the date in which the order was placed will appear 

here along with a 4-digit reference number. 

In Stock: Use this feature to help track and manage which 

items you ordered and currently have in your store as ‘brass and 

glass’ prototypes. See the Show In Stock section for more informa-

tion on In Stock management.

Live Preview: Rotate, zoom, and view your design from all angles 

by double-clicking on the selected model’s thumbnail. To rotate the 

model, hold down the right mouse button. To zoom in and out, roll the 

mouse’s wheel. Live Preview behaves in the same manner as does 

moving an item on the SketchPad and is a helpful tool, which allows 

you to revisit a design up close when managing your inventory. 

Want to take a closer look?

When an item within a Custom Collection is selected, 

a yellow highlighted box appears around the design. 
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Publish Design
Once you’ve customized a collection of designs that you are pleased with and saved them under Custom 

Collections, you will need to publish them so they become searchable within CounterSketch Studio as a 

Starting Point Inventory model. Publishing will render the design in every metal and gemstone combination 

available within CounterSketch Studio. This is to make sure the item will appear no matter what specifi c 

metal or gemstone color combination your client may decide they’re looking for. 

To get started, select an item and click on Publish Design. This 

will transfer the design into the Publish Queue that will appear 

along the right-hand side of the interface. The numbers to the 

left of the thumbnail image correspond to the order in which 

they will be published. If you wish to change this order, swipe 

over the number(s) you wish to change to highlight them in blue. 

Type in the new number and click outside of the fi eld to save. 

The numerical order will update accordingly. You may rearrange 

them as many times as you wish before you begin publishing.

If you decide that you want to delete a design from the 

Publishing Queue, simply click on the “X” to the right of the 

model’s information. CounterSketch Studio will ask if you do 

in fact, wish to remove the design. If you wish to remove all items in the Publish Queue, click Clear All. 

Deleting a design from the queue does not delete the item from the Collection. Remember however, that a 

design is not searchable in CS Mode until after it is published. 

When you are done selecting designs and are ready to publish, 

click the Start button located in the top right corner of the 

queue. A dialog box will appear announcing that the publishing 

process has begun. Sometimes it can take a moment for the 

V-Ray Publishing Window to appear, so keep this in mind. If at 

any time you wish to stop the process hit Cancel.  

Search For Designs in Your New Custom Collection

Congratulations! After your designs are successfully published, you can search for your custom designs dur-

ing a design consultation within CS Mode. Click on the Custom Collections Search Mode icon when in the 

Search tab during a design consultation with a client. This will limit the search to only your published models. 

You have the added control to narrow your search down even further by clicking on the Custom Collections 

drop-down menu and selecting an individual collection. All of the Custom Collections you’ve named will ap-

pear in any metal or gemstone combination your customer is requesting.

USER TIP
If you want to view all your 
published models at one 
time, click on the Published 
Designs section under Custom 
Collections located along the 
left-hand side of the interface 
to view them in a list. 

NOTE: Keep in mind that pub-

lishing renders each model in 

up to 576 metal and gemstone 

combinations. Although it’s up to 

you, it’s best to begin the pub-

lishing process at the end of the 

day. Depending on the number 

of items you have in the queue, 

publishing can take awhile. We 

strongly recommend hitting the 

Start button when you begin 

closing up shop. That way, the 

process will be complete when 

you arrive in the morning and 

your computer is never tied up 

when you need CounterSketch 

Studio for a design consultation 

with a customer. 
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Order Prototype
Another exciting feature within Inventory Mode allows you to take the Custom 

Collection models you’ve created and have these personalized designs 

manufactured into one-of-a-kind ‘brass and glass’ kit prototypes for your 

store’s physical inventory. Prices starting at $150 allow you to keep your 

store’s inventory up to date with the latest styling at a fraction of the cost.

With the item highlighted, click 

on Order Prototype to pull up the 

Mounting Sample metal and gem-

stone color menu. 

Select the Primary and Secondary 

Metal Color as the same color if you 

desire the piece to appear in one 

metal color only, or if you prefer a 

two-tone look, select different metal colors for different portions of the 

design. You will have the option of selecting the Center Gem Color, Side 

Gem Color, as well as the Accent Gem Color where applicable. Stuller 

offers you a variety of imitation gemstones to choose from.

NOTE: Primary Metal corresponds to the shank of a ring or the largest 

part of a design, while Secondary Metal corresponds to the smaller design 

element such as the setting. If in doubt, Render the item from within the 

Customize tab to determine which elements are Primary and Secondary.

Once you’ve selected your metal and gemstone choice(s), click Order. 

The program will tell you, “Please wait…” while it sends this order 

to Stuller. You should then 

receive the fi nal phrase “Your 

prototype Order has been 

placed”. Make sure to watch 

for this message. If you do 

not receive it, there may be an issue with your internet connection and 

your order was not received by Stuller! Click Cancel before placing the 

order to close the Order menu and void the selections made.

The Job Bag of the design is no longer overwritable once 

a design is ordered. When in the Customize tab, this is 

represented by a small yellow icon of a padlock appear-

ing in the bottom right-hand corner of the Job Bag.

Prototype Order Policy

All customized prototypes are alloy samples set with Cubic Zirconia 

and a heavy plating of gold and/or rhodium over a nickel plated base. 

Because of the individual nature of these models, it may take up to 

three weeks to receive the model from the time you’ve placed 

the order. Track your order through Stuller just as you would any 

CounterSketch Studio precious metal jewelry item, referencing 

the 4-digit code created when the order was placed. See the 

CounterSketch Studio manual for details about order tracking.

Show In Stock
With the Show In Stock feature, you have the ability to keep track 

of the items you have ordered and have in stock as physical 

prototypes. To mark an item as In Stock, select the item and click 

on Show In Stock. A check mark will immediately appear on the 

item’s line of information under the In Stock column. Remove an 

item from stock by clicking the Remove option that appears.

USER TIP
Quickly view and manage your In Stock items simultaneously by 
clicking In Stock Samples under the Inventory header. 

To keep things simple and organized, offi cially assign the task of 
managing your In Stock items to a member of your staff. When your 
prototype order comes in, have it be their job to manage marking 
within Inventory mode which items are now in your showcase.

Once an item is selected as In 

Stock, a green icon will show next 

to the design when searching under 

that specifi c collection, notifying you 

that you own this specifi c prototype. 

That way you can reference it dur-

ing a consultation with a client.

Edit Design
If you wish to do further alterations to a design, click Edit Design 

to open the item onto the SketchPad. After you’re done altering the 

design, you will need to save the new edited version. Select a port-

folio from the drop-down or create a new portfolio if desired. If this 

new altered design is meant to replace the previous design from 

which it came, to keep things simple we suggest saving over the 

old design’s Job Bag instead of to a new one. This is not possible 

however, if the previous design has been published. In this case, 

simply save the revised model in a new Job Bag.

USER TIP
View all of your ordered prototypes simultaneously by clicking on 
Ordered Samples located under the Custom Collections header on 
the left-hand corner of the interface. Use this sub-category to track 
and manage your physical prototypes and to help utilize the Show 
In Stock feature explained below.
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Move Design to...
If you wish to move an individual design to another collection or portfolio, select it and click on Move 

Design to... Choose the collection or portfolio you wish to move the design to from the drop-down 

menu that appears. 

Copy Design to...
Click on Copy Design to... in order to create a copy of the design selected. Choose the portfolio or 

collection you wish to move the copy to from the drop-down menu. 

Delete Design
Click on Delete Design to remove the model from the collection. You will receive a prompt asking if 

you do indeed wish to remove the design from the current project. If you choose to delete the design, 

this item will be permanently deleted from the Custom Collection, however it will still be searchable as 

an unedited SPI model within the program. 

NOTE: Although the original SPI will still remain searchable within CounterSketch Studio, deleting an 

altered model or collection from the Manage section will permanently delete this specifi c information from 

your computer. Make sure you’re ready to say goodbye!

View Favorites
View Favorites will allow you to view all starred designs within the same collection simultaneously. 

Use this method to verify that the collection is cohesive and just the way you want it. Within the 

Customize tab, verify that the item has been marked as a favorite. Simply click on the thumbnails at 

the bottom of the Favorites screen to view the designs and click on them a second time to deselect 

them. Visit the CounterSketch Studio 2.0 manual for more information.

If you wish to perform the same function to an entire collection, choose from Publish 

Collection, Move to Customer Portfolio, Copy to Customer Portfolio and Delete Collection, 

located underneath the Custom Collection title bar at the bottom of the screen. These uni-

versal features help you save time when managing your digital inventory. 

For example, when you wish to publish an entire collection, instead of adding each individual 

model to the Publish Queue one at a time, simply click Publish Collection and all models 

within the collection will be added simultaneously.

USER TIP
Click on the star next to a 
design to turn it yellow and 
mark it as a favorite.
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Customer Portfolios
Within the Order & Manage tab, Customer Portfolios are displayed in the 

same way and have the same features and functionality that Custom 

Collections do, the only exception being the inability to publish or order 

prototypes of designs that are from the Customer Portfolios section. 

See the Custom Collections vs. Customer Portfolios comparison box. 

Copy or move the individual item or entire portfolio to the Custom 

Collection section in order to perform these functions. 

You have the ability to move, copy and delete an entire Customer Portfolio with one click. If 

you choose the Move to Custom Collection option, the entire portfolio will be removed from 

the Customer Portfolio section of the program and will appear within Customer Collections. 

This feature is ideal if you have previously created and used portfolios for demonstrating 

CounterSketch Studio that do not relate to a specifi c customer. Maybe you or staff members 

have created demographic portfolios such as Bridal or Remount. Now with the addition of 

Inventory Mode, these portfolios may be better suited within the Custom Collections section 

of the program where they will become searchable as a collection. 

For Additional Help Using CounterSketch Studio 2.5
It’s hard to believe that CounterSketch Studio released less than a year and a half ago and we are already on to Version 2.5. Whether you are a new 

user or have been around since the birth of CounterSketch Studio, we are very pleased that you decided to join us on this exciting journey. If you have 

any additional questions on how to use the new tools explained in this User Guide Addendum, please visit the CounterSketch Studio User Forum and 

view the tutorial movies and training materials. As always, happy clicking!
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Use Inventory Mode to manage and create your own custom-
ized SPI. Once each design is perfected by you, publish the item, 
making it searchable in CS Mode. Publish will render the de-
sign in up to 576 diff erent metal and gemstone combina  ons. 
Take it one step further and order your customized prototype 
right from the CounterSketch Studio interface. During your next 

design consulta  on, search your exclusive Custom Collec  ons 
and display them within CounterSketch Studio exactly the way 
you want. Help your customer visualize the design with custom 
‘brass and glass’ prototypes which you can also order right from 
within the CounterSketch Studio interface. 

TUTORIAL

Using Inventory Mode
Learn the fundamentals to design, 

publish and order a Custom Collec  on of jewelry, 
and search your Custom Collec  ons.

1 Inventory Mode 

 In the 
upper right-hand 
corner of the 
CounterSketch 
Studio interface, click on CS Mode and se-
lect Inventory Mode. Depending on your 
preferences under Edit > Account Info, 
you may be required to enter a password 
to access the tools within this sec  on of 
the program. Once in  Inventory Mode, 
the en  re interface will be trimmed in 
yellow. The color change serves as a vi-
sual cue that you are now working within 
this new area of the program.

2 Search and Customize

Use the standard arsenal of 
tools to search 
and customize a 
collec  on of like 
items. Save as 
many designs as 
you would wish 
in your collec  on 
within the Custom 
Collec  on’s Job 
Bag column.

Within Inventory Mode, the best prac-
 ce while designing a collec  on is to 

save only fi nalized designs to a Job Bag 
as opposed to CS Mode where you 
are encouraged to “storyboard” or 
save each step-by-step change during 
the consulta  on. 

3 Name the Collec  on 

Click the text box next to the 
Title fi eld under Custom Collec  on and 
name your new Custom Collec  on. Be 
crea  ve – this informa  on will transfer 
to CS Mode where you will search in 
front of your customers. 

4 Order & Manage

 Click the Manage tab to view 
your Custom Collec  ons and Customer 
Por  olios at a glance, in list form along 
the le  -hand side of the screen. You can 
manage all of your CounterSketch Studio 
designs within this tab, however for the 
purposes of this tutorial we will focus on 

making your Custom Collec  on search-
able in CS Mode and demonstrate how 
to order prototypes. 

5 Custom Collec  ons

 Click Custom Collec  ons under 
the Inventory  tle bar along the le  -
hand side of the interface. Use the scroll 
bar to peruse all Custom Collec  ons and 
locate the collec  on created in Steps 1-3. 

6 Make a Design 
Searchable 

Each Job Bag within the collec  on is 
represented by a thumbnail image. To 

make these items searchable, click 

Publish Selected.

7 Publish Queue

The items you select to pub-
lish are then transferred to the Publish 
Queue located on the right-hand side 
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of the interface. To become searchable 
each design must fi rst be published, or 
rendered in every metal and gemstone 
combina  on applicable for that model. 
This process will take  me and during 
this process you will not be able to work 
within CounterSketch Studio. It is rec-
ommended to wait un  l the end of the 
day and publish the items overnight. To 
begin this process click Start. When com-
plete, a small check mark will display un-
der the Publish column within the Order 
& Manage tab. When you return to CS 
Mode, your item will now be searchable 
as a customized SPI model. 

8 Order Prototypes

Order any customized de-
sign as a ‘brass and glass’ prototype 
from within Inventory Mode’s Order & 
Manage tab. Select the model and click 
Order Selected. 

The Moun  ng Sample order menu 
will appear. Choose the Primary and 
Secondary Metal colors as well as the 
Center, Side and Accent Gem colors. 
Click Order to proceed. A dialog box 
will appear repor  ng that the order has 

been placed. In the event you have not 
already published the ordered items, 
they will automa  cally be added to the 
Publish Queue. CounterSketch Studio 
assumes you would like to make these 
exclusive customized prototypes search-
able as Star  ng Point Inventory within 
CS Mode. 

9 Mark as In Stock

Once your store receives the or-
dered prototypes, return to the Order 
& Manage 
sec  on of 
the program and click Show In Stock next 
to each corresponding model.

10 Search Custom 
Collec  ons

Return to CS Mode. Located within the 
Search tab, choose from the op  ons to 

search the en  re CounterSketch Studio 
Library or choose to narrow the search 
to your Custom Collec  ons by selec  ng 
the Custom Collec  ons icon. Search all 
of your Custom Collec  ons or fi lter the 
search criteria and confi ne it to a specifi c 
collec  on by selec  ng it from the drop 
down menu. Specify the metal type, cen-
ter stone and side gem colors. Click Start 
Search. Viola! You and your customers 
can now view your exclusive line of jew-
elry the way you want it to appear! 

When searching within a specifi c col-
lec  on in which you’ve marked items 
that are in stock, a small green icon 
will appear next to the model for 
easy iden  fi ca  on.



CounterSketch Studio Technical Support

Weekdays: 8:30 AM - 5:30 PM CST

Toll Free: 1.888.357.6272

Email: countersketch@gemvision.com 

Stuller CAM Services Support

Weekdays: 8:00 AM - 6:00 PM CST

Toll Free: 1.800.877.7777 ext. 3804

Email: camservices@stuller.com

Visit the CounterSketch Studio User Forum to connect 

online with Gemvision staff and other users and to share 

information and resources. Access tutorials, tips, news, and 

up-to-the-minute announcements direct from Gemvision!

www.countersketchstudio.com/forum

Maximize your investment in CounterSketch Studio by 

promoting your custom design capabilities through the 

Consumer Marketing Program!

www.gemvisionadvertising.com/css

Still have questions?


